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Quick-start tutorial

INTHIS CHAPTER

e Exercise 1: Raster tracing

e Exercise 2: Batch vectorization

ArcScan for ArcGlI S software has the tools you need to convert your
scanned raster images into vector-based GIS layers. This process can be
performed interactively or in an automated fashion.

The easiest way to learn how to use ArcScan is to complete the exercisesin
thistutorial.

Exercise 1 shows you how to set up the raster snapping options and
environment, snap to raster cells, and trace raster cells to create line and
polygon features.

Exercise 2 teaches you how to edit araster layer to remove unwanted cells,
apply vectorization settings, preview the vectorization, and generate features
using the batch vectorization mode.

Each of these exercises takes between 15 and 20 minutes to complete. You
have the option of working through the entire tutorial or completing each
exercise one at a time.



Exercise 1: Raster tracing

ArcScan makes it easy to create new features from
scanned raster images. This process can significantly
reduce the time it takes for you to incorporate raster data
into your vector database.

In this exercise, you will generate features from a scanned
parcel map by interactively tracing raster cells. You will
begin by starting ArcMap and loading a map document that
contains the raster dataset and two shapefiles.

Starting ArcMap

Before you can complete the tasks in this tutorial, you must
start ArcMap and load the tutorial data.

1. Double-click a shortcut installed on your desktop or use
the Programs list in your Start menu to start ArcMap.

2. Click the Open button on the Standard toolbar.
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. Navigate to the ArcScanTrace.mxd map document in the
ArcScan directory where you installed the tutorial data
and select it (C:\ArcGIS\ArcTutor is the default
location).

4. Click Open.

Open HE
Lok in: [ £ &rcScan ] « & o B

| ExerciseData

Filename:  [ArcScanTrace.mxd

o @)

j Cancel

v

Files of type: [archap Documents [“nxcl

I Open as read-ony

Changing the raster layer symbology

Raster layers must be symbolized as bi-level images to use
the ArcScan tools and commands. You will change the
raster symbology from stretched to unique values.

1. Right-click the ParcelScan.img raster layer in the
ArcMap Table of Contents and click Properties from the
context menu to display the Layer Properties dialog box.

2. Click the Symbology tab on the Layer Properties dialog
box.

Geressi]| Source | Etent | Deglr  Symboiogy | Febde | Jora & Relstes |

Urst Vighses b =
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3. Inthe Show box, click the Unique Values display option. e

. ﬁ Drata Wiew
4. Click OK. B i
Zoom Data »
Layes Properies HE
| S| s D | e | Zoom Layout 3
| D st amsigrin  coken 10 nach vakse Bookmarks [ G Create...
ooy Fokd |7 ol Schbes Toolbars » Manage. ..
it S)|I Bl E Table OF Conkents
I::'-r- v et |T Skatus Bar Trace polygons
T Cwerflow Labels
Identify Results
E Scrollbars
agieavaue | assveve | Rewwe | [ | &5 Rulers
Doy Wellataan 1| lﬂ- Glides
Grid|
— Data Frame Properties. ..

© When the display refreshes, you should see the trace area.
Locating the trace area

Spatial bookmarks are named extents that can be saved in
map documents. Creating a bookmark for areas that you
visit frequently will save you time. For information on how
to create and manage spatial bookmarks, see Using 7
ArcMap. -
” . . N
You will now zoom to a spatial bookmark created for this - b
exercise. o 056‘
1. Click the View menu, point to Bookmarks, and click 5 i
Trace lines to set the current view to the edit area of the . 19257 2
exercise. —
z (b8 =«
v (059 3
5 060 ¥
1
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Start editing 2. Set the maximum line width value to 7. This setting will
ensure that you are able to snap to raster cells that
represent the lot boundaries.

3. Click OK.

The ArcScan extension is only active in an edit session. The
Start Editing command enables you to begin an edit session.

1. Click the Editor menu and click Start Editing to begin the

edlt scssion. Raster Snapping Dptions ﬂ E
General |
— Fiaster Calor
J Editor = | Raster snapping occurs at foreground cells
Foreground - Backaround l:l Toggle Colars |
Stop Editing
P — Raster Line Width
_ Snap to raster inear features with a width lezs than or equal ta this
[Move. .. walue.
b awirriuirn width: |7 1-100.0
Sl e e |
" Divide., o
N - — Raster Solid Diameter
BUffer... Snap ta raster solid features with a diameter between these values.
% CopyParalel.. Minwidh [5 Mewwicth [B
Merge...
Uniar r~Hol
T Huoles in raster features are ignored while snapping. Hole size iz a
- diagonal pixel length.
Clip, ..
- Hole size: ID raster pizels.
More Editing Tools b
#2 Yelidate Selection,..
SHARRING, . 0K I Cancel Apply
—_— 1
Qpkions. ..

Setting the raster snapping options

Raster snapping requires settings that influence the
behavior of the tracing. These options are set in the Raster
Snapping Options dialog box.

1. Click the Raster Snapping Options button on the
ArcScan toolbar to open the Raster Snapping dialog box.

Raster: IParceIScan.img j ‘ Al ‘ Weckorization
!

0
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4. Click the Editor menu and click Snapping to open the Creating line features by tracing raster cells

Snapping Environment dialog box. Now that you have set up your raster snapping

environment, you are ready to begin tracing the raster cells.

Editar = . . . .
) . ELW You will use the Vectorization Trace tool for this step.
_ EEEEH 1. Click the Vectorization Trace button on the ArcScan
Save Edits
> toolbar.
(=1 T=0
S
A Divide, ., Weckorization * o0} I |
N Guffer...
il Copy Parallel. ..
[IErdE. ..
Uriom
L 2. Move the pointer until it snaps to the intersection of the
T eEmas b lot boundaries and click to start tracing.
#3 Walidate Selection, .

Cpkions. ..

5. Click the plus sign next to Raster to expand it.

6. Check the Centerlines and Intersection options for raster
snapping.

Intersection

Snapping Environment B
Layer | Werkex | Edge | End |
Parcellines O O O
ParcelPolygons O O O

r
-l Centerlines -
[ Corner 1 6 I
W Intersection ——— J
[ Ends
. D Solid LI
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3. Point the Vectorization Trace tool downward and click to
start creating the line feature.

4. Continue to point and click with the Vectorization Trace
tool to trace the exterior boundary of the lots.
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5. Once you have finished tracing around the lot

boundaries, press F2 to finish the sketch.

T 065
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A line feature now represents the exterior boundaries of the
scanned parcel lots.
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Creating polygon features by tracing raster cells

Target: |ParcelPolygons ;I
Parcelines

Now that you have successfully traced raster cells to

create line features, you will create polygon features using
the Vectorization Trace tool.

B[ arcelPolygons

1. To get a better view of the area that will be traced, you
need to zoom to the bookmarked extent called Trace
polygons. Click the View menu, point to Bookmarks, and

click Trace polygons.
&, oatavew 2. Click the Vectorization Trace button on the ArcScan
& Layouk Visw tOOlbal’
Zoom Data 3
Zoom Layout 5 1
Bookmarks N B create... Yectorization ¥ S |
Toolbars » Manage. ..
E Table Of Contents Trace lines
[v status Bar
Overflaw Labels
Identiy Resuls 3. Move the pointer until it snaps to the lower-left corner of
g Sulin lot 061 and click to start tracing.
& Rulers
lq- Guides
Grig
[raka Frame Propetties, .
: . o, o,
Changing the edit target layer =t 060 o
You must change the edit target layer from ParcelLines to
ParcelPolygons to create polygon features when tracing.
. . o o
1. Click the Target dropdown box on the Editor toolbar and =t O 6 1 =+
choose ParcelPolygons.
o oo
T 062 =
o Mracy
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4. Point the arrow toward the lower-right corner of the lot

6. When the cursor has returned to the starting point of the
and click to start creating the segments of the polygon

trace, press F2 to complete the polygon.
feature.
= 2
: 060 = o Ueu
¥ 061 =
Pl o
¢ 062 ©o e
- Moy
- e W T T

5. Continue to trace the lot boundary in a counterclockwise
direction.

v 060 =
= 061 =

73
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Finishing your edit session

Once you have finished tracing the raster cells and have
disabled the Vectorization Trace tool, you can stop editing
and complete the exercise by saving your edits.

1. Click the Editor menu and click Stop Editing.

J Editar = |

Stark Editing |

Save Edits
[ [RT=
Sl .
/ Divide...
N Buffer...
47 Gopy Parallel., .
Merge,., .
Wi
Intersect
Clig...
IMore Editing Tools »
#3 Walidate Selection. ..
Snapping. .

Options.. .

2. Click Yes to save your edits.

Do you wank bo save vour edits?

QUICK-START TUTORIAL

In this exercise you learned how to set the raster snapping
options and environment, snap to raster cells, and trace
raster cells to create new line and polygon features. These
steps covered the main components of the raster tracing
process. The next exercise will show you how to edit a
raster layer and automatically generate features for an
entire raster layer using the batch vectorization tools.

15



Exercise 2: Batch vectorization

In this exercise, you will edit a scanned parcel map to
remove cells from the raster that are not in the scope of the
vectorization. Once the raster has been cleaned up, you will
generate features using the batch vectorization mode. You
will begin by starting ArcMap and loading a map document
that contains the raster dataset and two shapefiles.

Starting ArcMap and beginning editing
Before you can complete the tasks in this tutorial, you must
start ArcMap and load the tutorial data.

1. Double-click a shortcut installed on your desktop or use
the Programs list in your Start menu to start ArcMap.

2. Click the Open button on the Standard toolbar.

D=zEE

. Navigate to the ArcScanBatch.mxd map document in
the ArcScan directory where you installed the tutorial
data and select it (C:\ArcGIS\ArcTutor is the default
location).

4. Click Open.

98]
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Open [Z1x]
Look i | 3 rcGean sl e®m s E

| |ExerciseData

T Arcsean Trace

File name:  [arcScanBatch mxd

=+

j Cancel

2

Files of pe: | &uchap Documents ()

I~ Open as readonly

Changing the raster layer symbology

Raster layers must be symbolized as bi-level images to use
the ArcScan tools and commands. You will change the
raster symbology from stretched to unique values.

1. Right-click the ParcelScan.img raster layer in the
ArcMap Table of Contents and click Properties from the
context menu to display the Layer Properties dialog box.

2. Click the Symbology tab on the Layer Properties dialog
box.

———

Geressi]| Sensce | Evtert | Dogley Symbiiogy | Freks | Jora & Relstes |
Ghew

Urigs Vighoes
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3. Inthe Show box, click the Unique Values display option.
4. Click OK.

Geressi| Sensce | Evdert | Dogley Symboiogy | Fueke | Jora & Fistes |
e
Duam 1aste axvigning & coke 1 nack vakse

Cokex Schomey
&0 |
[isei [care T

FT———
VALLE

Locating the cleanup area

Spatial bookmarks are named extents that can be saved in
map documents. Creating a bookmark for areas that you
visit frequently will save you time. For information on how
to create and manage spatial bookmarks, see Using
ArcMap.

You will now zoom to a spatial bookmark created for this
exercise.

1. Click the View menu, point to Bookmarks, and click
Raster cleanup to set the current view to the edit area of
the exercise.

QUICK-START TUTORIAL

| @ Draka Wiz
E& Layouk View
Zoom Data »
Foom Layout »

4 E@ Create, ..
Toolbars »
E Table Of Contents

|T Skatus Bar

Cverflow Labels

Manage. ..

Cell selection

Identify Resulks
E Scrollbars
EF Rulers
Iq- Glides
Grid

Data Frame Propetties. .

When the display refreshes, you should see the edit area.
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Start editing

The ArcScan extension is only active in an edit session. The
Start Editing command enables you to begin an edit session.

1. Click the Editor menu and click Start Editing to begin the
edit session.

Cleaning up the raster for vectorization

When performing batch vectorization, it is sometimes
necessary to edit the raster image prior to generating
features. This process is referred to as raster cleanup and
involves the removal of unwanted cells from the raster

18

J Editor = |

Stop Editing
Save Edits

[ave, ..
7 [

// Divide. .

N Euffer...

A Copy Parallel. .
Merge.. .
Ui
Intersect
Clip,..

Mare Editing Taols

# Yalidate Selection, .

Snapping. ..

Qpkians, .

3

image that are not in the scope of the vectorization.
ArcScan provides the tools to perform raster cleanup.

You will now use the Raster Cleanup tools to remove
unwanted text from the ParcelScan image.

1. Click the Raster Cleanup menu and click Start Cleanup
to start the raster cleanup session.

Faster Cleanup = |

| sicen 1)

Stop Cleanup

a

Raster Painting Toolbar

Erase Selected Cells

Eill Selected Cells

Save

SaVE A5,

2. Click the Raster Cleanup menu and click Raster Painting
Toolbar to display the Raster Painting Toolbar.

Raster Cleanup |

Start Cleanup
Stop Cleanup

o

Raster Painting Toolbar

Erase Selected Cells

Fill Selected Cells

Save

Save As...
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3. Click the Erase tool located on the Raster Painting
toolbar.

Bul@ N~ = 2% h|%

)

4. Click and hold down the left mouse key and erase the
text located at the top of the parcel lot.

QUICK-START TUTORIAL

5. Continue to erase the text with the Erase tool until it has
been completely removed from the image.

In addition to the Erase tool, the Raster Painting toolbar
supports another tool designed to erase cells. This tool is
called the Magic Erase tool, and it allows you to erase a
series of connected cells by simply clicking or dragging a
box around them.

6. Click the Magic Erase tool located on the Raster
Painting toolbar.

bl N = 7 b

)
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7. Drag a box around the text located in the center of the Using the cell selection tools to assist with raster
parcel lot to remove it. cleanup

In the previous steps, you learned how to use the Erase and
Magic Erase tools to remove unwanted cells from the
raster image. However, if the image you are working with
requires much cleanup, these techniques could be time
consuming. To help streamline this process, you can use the
cell selection tools in conjunction with the raster cleanup
tools.

1. To get a better view of the edit area, you need to zoom
to the bookmarked extent called Cell selection. Click the
View menu, point to Bookmarks, and click Cell selection.

ﬁ Daka Wiew
. & Layouk Wigw
The text 1s now removed from the raster. o e S

Zoom Layouk »
d EB Create. ..

Toolbars » Manage...

E Table OF Contents Raster cleanup

[« Starus Bar

COwerflaw Labels

Identify Resulks
E Scrolbars
i Rulers
I?Y- Guides
Grid

Diata Frame Propertias. .
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When the display refreshes, you should see the edit area.

3. In the Select connected cells dialog box, enter a value of
500 for the total area of raster pixels. This expression
/,-\ 48 42,04 % will select all the cells that represent text in the raster.
o} !
o _ - ;
= 2] 00 = @) 4. Click OK.
<__ LY L':-.S - ‘T:_;
2"‘,_ a5 (-] w (] % Select connected cells HE
UE';, 1 67 Choosze the type of connected cell selection:
foa) O O 2 ; ;51 '3-,'(:) h‘ ITotaI area of connected cells =
1.7_'*
00 E} 2‘? 02 D ﬁ Choose where to search for connected cells:
g‘_é IFDreground j
o
'f_? O O 3 *TJ‘J 100 Chooze the operatar to constrain how the values are
- O 2 1 :“_’J'_ Iless than j
o 1
e MMA g Enter total area;  |500 razker pinels
. . . e Chooze how the result will affect the cument raster
2. Click the Cell Selection menu and click Select -
IEreate a new selection j
Connected Cells.
[~ Select only from the cument extent
Cell Selection oK I Cancel |
1 t Connected Cells. ..
Interactive Selection Target  »

B Clear Selected Cells

Save Selection As...

QUICK-START TUTORIAL

21



The cells that represent the text in the raster are now

The selected cells are now erased.
selected.

(\ 48 [ 4204 % [ \
£d ol o
== b % h aad ‘—D"
¥ g |9 O g

e .
2 002 N\et—
o0 Ti 020 =
- 003 d—m

v 021 +
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Using the vectorization settings
5. Click the Raster Cleanup menu and click Erase Selected

Batch vectorization relies on user-defined settings. These
Cells to delete the selected cells. settings influence the geometry of the generated features.
These settings may vary depending on the type of raster
rmre— data you are quking with. Once you have determined the
' appropriate settings for your raster, you can save them
within the map document or to a separate file. You will use
the Vectorization Settings dialog box to apply the settings.

Stop Cleanup

ﬁ' Raster Painting Toolbar

c 1. Click the Vectorization menu and click Vectorization
Eil Sefect=d Cells Settings to open the Vectorization Settings dialog box.
Save
Save s,

Weckorization ™

Vectorization Setkings. ..
Shows Pressiem

| Generate Features..,

Opkions. . .
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You will now modify the vectorization settings to ensure

optimal results when generating features.

N

Click Apply to update the settings.
Click Close.

v W

Yectorization Settings K

Intersection Solution: IGeDmetricaI 'l
b axirnurn Line b/idth: |1|D 1-100.0

Change the Maximum Line Width value to 10.

Change the Compression Tolerance value to 0.1.

¥ Compression Tolerance: IU.'I 0.001 -50.0
L

M Smoothingweoht  [3 1-200

[~ Gap Closure Talerance: IU— 1-1000.0
ARGl [ o100

Huole Size: IU— 0-1000

Shyles... | Load or zave a pre-defined vectorization style
About YWectarization | Apply | Cloze

4] 5]
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00

Previewing the vectorization

ArcScan provides a way to preview the batch vectorization
prior to generating features. This can help you save time by
allowing you to see how the settings will affect the
vectorization. When the settings are changed, the preview
can be updated by clicking the Apply button located on the
Vectorization Settings dialog box. This design allows you to
fine-tune the vectorization settings.

1. Click the Vectorization menu and click Show Preview.

Vecktorization =

Wectorization Settings...

Show Preview

| Generate Features, .,

options. ..

The vectorization preview is displayed in the map.

- N
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Generating features

The final step in the batch vectorization process is to

generate features. The Generate Features dialog box allows

you to select the vector layers that will store the new
features and execute the vectorization.

L.

2.

2
J.

Click the Vectorization menu and click Generate
Features.

eckorization ™

Yectarization Settings. ..
|T Shiow Preview

|

Generate Features. ..

opkians. ..

Choose the ParcelLinesBatch layer.
Click OK.

Generate Features ﬂ E

Chooze the line layer to add the centerlines bo;

[~ Save the average width of each line feature to an existing field:
Jid I

¥ Generate polygons where the maximum line width setting is exceeded

Choose the polygon layer to add thees polygons to:
I ParcelPaolygonzB atch j

™ Generate features far the cumently selected cells only

Tip: This dialog generates features from the full extent of the raster.
To generate features for a specific extent, uze the Generate Features

Inside Area tool.
ok, I Cancel

24
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4. Right-click the ParcelScan.img raster layer in the
ArcMap Table of Contents and click Zoom To Layer
from the Context menu to view all of the new features
that were generated.

Copy

X Eemowve

Open Attribute Table

Joins and Relates 3

@2 Zoom To Rasker Resolution
Wisible Scale Range 3

Sel Mata Saurce, ..

Save As Layer File. ..

Propettiss. ..

When the display refreshes, you should see the vector
features that now represent the raster cells.
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Finishing your edit session

Once you have finished generating features, you can stop
editing and complete the exercise by saving your edits.

1. Click the Editor menu and click Stop Editing.

J Editor * |

Start Editing

Save Edits

[EE
Split..
.// Divide. .
W Euffer...
47 Copy Parallel,..
Merge...
Ui
Interseck
Clipi.
More Editing Taols »
#% Yalidate Selection, .

Snapping. ..

Qptions, ..

2. Click Yes to save your edits.

Do you want o save your edits?

Mo | Cancel |

QUICK-START TUTORIAL

In this exercise you learned how to use the raster cleanup
and cell selection tools to edit a raster layer, apply
vectorization settings, preview the vectorization, and
generate features. These steps covered the major
components of the batch vectorization process.

This concludes the tutorial. You have been introduced to the
most commonly used tools and commands for raster tracing
and batch vectorization. The rest of this book will present
additional information that will help you better understand
the ArcScan extension.
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